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Overview

ECO IV introduces two new components for use in ASP.NET applications. These components work with the new ASP.NET
DataSourceControl approach for creating websites. Although it is possible to use standard ECO handles in ASP.NET
applications it is recommended that these new components (EcoDataSource, EcoSpaceManager) are used instead, and

therefore these are the only components that will be covered in this tutorial.
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Prerequisites and goals

Prerequisites

To successfully follow this document the user should have read the preceding articles in this series and have a copy of the
model created. You should also have at least one author instance in your database, that author should also have at least
one article.

Goals
By the end of this document you will be able to
» Create ECO ASP.NET applications.
» Use instances of ECO modeled classes with standard ASP.NET controls such as DataGridView.
» Create a master/detail web UI.
« Bind drop down lists of objects to the property of a single object.

» Validate objects.
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3 Creating the application

1. From the File->New menu select Other.
2. In the TreeView on the left hand side select the "ECO" node.
3. Select the "ECO Delphi.NET Project Wizard" and click OK.

Ikern Cakeqoties:

7] C# Projects
(=771 Delphi For \MET Projects ﬁ

(7 €55 Layouts Eco Delphi.Net
7] Mew Files Project Wizard

7] Design Projects

7 Eco

77 Other Files

7 Unit Test

77 Weh Documents

Cancel ] [ Help

4. In the Presets combo box select "Webform application".

5. In the Name input type "QuickStartASP".
6. As we are going to reuse the same model you should uncheck the "Add a model with empty package" check box.

7. From the drop down list select SglConnection for the Storage.
8. Leave "Use a PersistenceMapperProvider" checked.

9. For the User Interface section leave the default values checked.

[/ JEGOProjectWizand! x|

Presets: Mame:
‘Webform Application D Quick StartASP
Location:
C\OtherData"CapableCbjects docs  Quick Start\BD 5" SourceCode"07 [:]
Model User interface
[ Add a model with empty package [] VICLNET

ASP.NET

WebForm (EcoDataSource)
Persistence
Storage: [] WebForm (Handles, old style)

SqlConnection D [] WebService

[5] Use a PersistenceMapperProvider Global asax

[] Remete

C Objects OK ] [ Cancel
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10. Click the OK button.
11. Add the existing business classes project to your solution and ensure it is set to build first.

12. Right-click the References node under QuickStartASP in the project manager, and select Add Reference from the
context menu,

13. Select the Project References tab.
14. Select the business classes project.
15. Click the Add Reference button.

16. Click the OK button.

17. Now build all projects to ensure that the business classes DLL exists in order for the ECO designers to read model
information from it.

18. Double-click the EcoSpaceUnit.pas file in the project manager to bring up the design surface for the EcoSpace.

19. In the tool bar at the bottom of the EcoSpace click the Select Packages button.

bR ETHhELR

20. Double-click the business classes package in the list of Available UML Packages on the left, the package will now move
into the list on the right "Selected UML Packages".

21. Click OK.

ASP.NET configuration
1. Ensure that QuickStartASP is the selected project in the project manager.
2. Choose the menu option Project->Options.
3. In the form that appears choose the Debugger/ASP.NET node in the tree view on the left.

4. Remove the application name from the HTTP address.

Projecptions o mckstantASPodlll ﬂ
gpplic.‘lation Browser
ompiler

Compiler Messages Launch browser

Linker Start page:

Directories/Conditionals Default.aspx

Signing

5-Debuager HTTP address

Symbal Tables http:/flocalhost: 3080 Default. aspx
Environment Block
ASP.NET

Build Events Server

Host with web Server
Server:

Cassini Web Server

Start Cassini: | When project is run

[pefault oK ] ’ Cancel ] ’ Help
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Although these final steps are not mandatory or related to ECO I'd recommend performing them in order to work with a URL
that will be very similar to the one used once your application is deployed.

Persistence configuration
1. Double-click the PersistenceMapperProvider.pas file in the project manager to open its designer window.
2. Right-click PersistenceMapperSqlServerl and choose SQL Server Setup from the context menu.

3. Set the ConnectionString property on SglConnectionl to connect to the database created in the earlier projects.
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New ECO ASP.NET components

In ECO IV the interaction between objects in an EcoSpace and the web Ul controls is handled by two new components.

EcoSpaceManager

This component makes an EcoSpace instance available during the rendering of a web form, at the end of the rendering
process this component will ensure that the correct action is taken to release the EcoSpace instance. This behavior depends
upon a number of settings on the EcoSpaceManager and also in the web.config file. Important properties of this component
are:

¢ ID: The unique name of this component.

* EcoSpaceTypeName: The drop down list will present a list of EcoSpace types available in your project. In this case there
will be only one, but it is possible to have different types of EcoSpace in the same project with each having its own model.
When the EcoSpace property of this component is read it will ensure that an EcoSpace of the specified type is returned.

« SessionStateKey: The first time the EcoSpace property is read this component will first see if there is a key in the
ASP.NET Session with the given name. If there is then the EcoSpace held in the session with this key will be returned.

» SessionStateMode: This setting specifies whether or not to place the EcoSpace instance into the ASP.NET session at the
end of the page render.

« Always: The EcoSpace instance will always be put into the session at the end of the page render.

< IfDirty: The EcoSpace instance will be put into the session at the end of the page render only if it has dirty objects
(modified persistent objects which have not been saved to the data storage.)

« Never: The EcoSpace instance will not be put into the session, it will either be disposed of or placed back into a pool. If
there are dirty objects in the EcoSpace at the end of the page render an exception will be thrown.

EcoDataSource

This component is responsible for controlling interaction between objects in the EcoSpace and the web Ul controls. It obtains
its EcoSpace instance from an EcoSpaceManager. Important properties of this component are:

« AddDefaultProperties: If set to True then columns will be created automatically at runtime to represent the data made
available by the Expression and PSExpression properties. If a column has been added at design time with a conflicting
name then it will take precedence.

» AddExternalld: If set to True a column will be added named "Externalld" which provides read only access to a string
which can be used to uniquely identify an instance of a modeled business class. This option is only valid if the result of
evaluating the expressions results in a single business object or a collection of business objects.

» DeleteMode: Specifies the action to take when the user clicks Delete on a new web control such as GridView:
« Disallow: No action will be performed.

« Delete: Deletes the selected object, this option is only valid if evaluating the Expression and PSExpression properties
returns a single object or a collection of objects.

» Unlink: The selected object will be removed from the list, this option is only valid if evaluating the Expression property
returns a multi role, such as self.purchaseOrder.lines.

« EcoSpaceManagerlD: Identifies which EcoSpaceManager to obtain an EcoSpace instance from during rendering of the
web form. At design time this is used to identify the EcoSpace type and therefore the model information.

» Expression / PSExpression: These expressions are executed automatically during rendering of the web form. First the
PsExpression is executed, and then the Expression is evaluated. If there is no PSExpression then the Expression is
evaluated against the EcoSpace, otherwise it is evaluated against the result of executing the PsExpression.
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« InsertMode: Specifies the action to take when EcoDataSource.Insert is executed. You should use the Insert so that
ASP.NET is aware the binding list has changed.

* Disallow: No action will be taken.

« AddNew: Adds a new instance of the correct type to the collection. This is only valid if evaluating the expressions
results in a collection of business objects, either Allinstances of a class or a multi role member of a business object.

* CreateNew: Always creates a new instance of the correct class type.

« ManualUpdate: If set to False then any changes made via Insert / Delete / Edit will be updated to the data storage
immediately. If set to True then no update will be performed, in which case the developer must call UpdateDatabase or
ensure that the EcoSpaceManager.SessionStateMode is set appropriately to allow the page rendering process to finish
with dirty objects.

« MemberVisibility: Specifies the maximum exposure level of properties that will be added automatically when
AddDefaultProperties is set to True.

* NullRowMode: When the resulting element of evaluating the expressions is a collection this property specifies where to
add an empty row representing NULL. This can be useful for example when you wish to present a list of objects for the
user to choose a value from and you wish to allow them the option of selecting nothing.

* None: No additional row will be added to the collection.
< First: An additional row will be added to the top of the collection.
* Last: An additional row will be added to the bottom of the collection.
« IfEmpty: An additional row will only be added to the collection if the collection is empty.
» SupportSorting: If set to True then web Ul controls that implement sorting will enable their sorting functionality.

« ValidateRowOnlInsert / ValidateRowOnUpdate : If set to True the ValidatingRow event will be executed, providing you
with the option to validate the changes to the object before they are applied permanently to the local EcoSpace cache.
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4.1 Logical flow
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This diagram illustrates the life cycle of an ASPX page request from the point of view of the ECO ASP .NET compnents.

When web Ul controls are data bound to an EcoDataSource they will attempt to read the data values of the component. If
the data has not already been determined the EcoDataSource will execute its expressions like so
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1. Set the evaluation context to null (the EcoSpace.)

2. If there is a PsExpression then execute it and set the evaluation context to the result of the execution.
3. If there is an Expression then evaluate it in memory and set the context to the result of the evaluation.
4. Set the resulting element (to data bind to) to the result context.

In order to evaluate expressions etc the EcoDataSource requires an instance of an EcoSpace. To obtain this instance it will
retrieve it from the EcoSpaceManager's EcoSpace property. To return an EcoSpace the EcoSpaceManager will go through
the following process

1. If the EcoSpace property is not null then return the value immediately. The property will not be null if the EcoSpace
property has already been read during the page rendering process.

2. If there is an EcoSpace stored in the session under the specified key (the value entered into SessionStateKey) then
return this value.

3. If there are any EcoSpaces available in the pool (see the Web.config file for setting the pool size) then
1. Get an instance from the pool.

2. If there is a SyncHandler on the PersistenceMapperProvider then get all changes made by other users and sync them
into the EcoSpace's cache.

3. Return the fetched EcoSpace.
4. Otherwise create a new instance of the specified EcoSpaceTypeName will be created and returned.

Subsequent access to the EcoSpaceManager.EcoSpace property will return the instance last returned. This value is held
until the end of the page rendering process when the EcoSpaceManager is unloaded. At this point the EcoSpace manager
will relinquish its reference to the EcoSpace and go through the following process

1. If the SessionState is set to Never

1. If the EcoSpace contains dirty objects then throw an exception.

2. Otherwise return it to the pool.
2. If the SessionState is Always

1. Put the EcoSpace into the session using the value in SessionStateKey as the key.
3. If the SessionState is IfDirty

1. If there are dirty objects in the EcoSpace then put it into the session

2. Otherwise return it to the pool.

When returning an EcoSpace to the pool the EcoSpace will only be added back if the following conditions are true

1. The number of items in the pool is less than the maximum pool size in web.config.

2. The amount of time elapsed since the EcoSpace instance was created is less than the max age setting in web.config.
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Creating a web form

Using the new ECO components for web forms means that there is no need for any kind of specialized "ECO web page".
Simply drop these new components onto any existing web form and you are able to access instances of your modeled
classes. As an exercise we'll recreate an ECO web form completely from scratch.

1. Open the designer for Default.aspx.

2. Delete the two ECO components on the form.

3. In the ECO|Web section of the component palette drop an EcoSpaceManager onto the form.

1. From the drop down list set its EcoSpaceTypeName to EcoSpaceUnit.QuickStartASPEcoSpace.

2. Note that the SessionStateKey will also default to the same value.

4, Now add an EcoDataSource to the form.

1. Set its name to AuthorDataSource.

2. From the drop down list set its EcoSpaceManagerID to EcoSpaceManagerl.

3. Use the [...] editor on the Expression property and set its Expression to

Aut hor . al | | nst ances

5. From the Web Data section of the component palette add a GridView control to the form.

1. Setits ID property to AuthorGridView.

2. Set its DataSourcelD to AuthorDataSource.

3. Use the [...] editor on the Columns property to remove all columns except for the following

~N o o b

AutoPublishArticles
Salutation
FirstName
LastName
FullName
EmailAddress

Password

. Rearrange the columns into the above order.

. Click each column in turn and give it an appropriate HeaderText property.
. Select the FullName column and ensure that ReadOnly is set to True.

. Click the Tasks button at the top right of the GridView.

ne Email address Passwot%l
i abc_123 abc 123
i\ abc_123 abc_123
i abc_ 123 abc_123
i abc_ 123 abc_123
i abc_ 123 abec_123

10
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8. Select the Auto Format option on the popup window and choose a nice color scheme.
9. Before closing the tasks window also set Enable Sorting to True.
10. Finally on the AuthorGridView set both AutoGenerateEditButton and AutoGenerateDeleteButton to True.

Now run the application and you should see data from the database that was added by the VCL.net application. If you see
nothing at all this is because you have no Author instances and GridView does not output any HTML when its data source is
empty.

Click the Edit column next to an Author and the Ul will change so that you may edit the information and then either click
Update to keep your changes or Cancel to revert. Clicking the Delete button will obviously delete an Author.

Adding new authors
1. Add a Button to the form beneath the AuthorGridView.
2. Set its ID to NewAuthorButton.
3. Set its Text property to New author.
4. Add QuickStartPackageUnit to the code-behind's uses clause.
5

. Set the button's Click event code as follows

uses
Qui ckSt ar t PackageUni t;

procedur e TDef aul t. NewAut hor Button_d i ck(sender: TObject; e: System Event Args);
begi n

Aut hor Dat aSour ce. | nsert;
end;

Re-run the application and click the "New author" button, you will see a new row appear.

Confirming deletion

Clicking the Delete link next to a row will delete the Author immediately. This is not ideal as it is quite easy to accidentally
click the wrong link on a web page. Next a JavaScript confirmation box will be added to ensure that the user really does wish
to delete the row.

. On the AuthorGridView set AutoGenerateDeleteButton to False.

. Use the [...] editor on its Columns property.

. In the Available Fields list at the top of the form expand the tree node entitled "CommandField".
. Select the child node entitled "Delete" and then click the Add button.

. Use the arrows to rearrange the Delete column so that it is at the top of the "Selected fields" list.

o o~ W N P

. At the bottom right of the form click the link entitled "Convert this field into a TemplateField".

11
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Convert this field into & T. ateField

7. Click the OK button.
8. Now switch to the ASPX view.

9. Look for a node named LinkButton in the following path

<body>
<f or n»
<asp: Gri dVi ew>
<Col ums>

<asp: Tenpl at eFi el d>
<l t enTenpl at e>
<asp: Li nkBut t on>

10. Change the LinkButton's ID to DeleteAuthorLinkButton.

11. Now switch back to the Design view and in the AuthorGridView.RowDataBound event add the following code.

procedure TDef aul t. Aut hor G i dVi ew_RowDat aBound(sender: TObj ect; e:
System Web. Ul . WebCont rol s. G'i dVi ewRowEvent Ar gs) ;

var
Del et eBut t on: Li nkButton;
begi n
i f (e.Row. RowType = Dat aCont r ol RowType. Dat aRow) t hen
begi n
Del et eButton : = e. Row. Fi ndControl (' Del et eAut hor Li nkButton') as LinkButton;
Del eteButton.OnClientdick := "return confirn("Are you sure you want to delete this
aut hor?");";
end;
end;

Now run the application again and click the Delete link. A dialog box will appear asking you if you are sure you wish to delete
the author. Clicking Cancel will abort the deletion, whereas clicking OK will continue as before.

12
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Auto publish articles Salutation First name Lastname  Full name Email address
Edit Delete Mr John Smith Mr John Smith  John(@Smith com password
Edit Delete Mr Ian Johnston ~ Mr Jan Johnston ian(@johnston co.uk password
Edit Delete Mr Peter Morris Mr Peter Morris peter morris(@capableobjects.com password

New author Microsofil ntennetEploTen a

\_?/ Are you sure you want to delete this author?

[ OK ] [ Cancel

5.2 Validating user input

This next exercise will implement validation for user input. Before allowing the EcoSpace to update the data storage the OCL
constraints entered against the class in the model will be evaluated. For each broken constraint an error message will be

displayed on the form. If there are any broken constraints the update will not be permitted.

Creating a static validator class
1. Create a new class
2. Name it StaticValidator and save the unit as StaticValidatorUnit

3. The implementation of the class is as follows

unit StaticValidatorUnit;

interface
uses
Syst em Web. Ul
System Web. Ul . WebCont r ol s;
type
StaticValidator = class(WbControl, |Validator)
private
FError Message: string
publ i c

constructor Create(ErrorMessage: string);
procedure Vali date;

function GetlsValid: bool ean;

procedure SetlsValid(const Val ue: bool ean);

property IsValid: boolean read GetlsValid wite SetlsValid;
end;

i mpl enent ati on

{ StaticValidator }

constructor StaticValidator.Create(ErrorMssage: string);
begi n

i nherited Create;

Sel f . Error Message : = Error Message;
end;

function StaticValidator.GetlsValid: bool ean;
begi n

property ErrorMessage: string read FErrorMessage wite FError Message;

13
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Result := Fal se;
end;

procedure StaticValidator. SetlsValid(const Val ue: bool ean);
begi n

/1 Do not hi ng
end;

procedure StaticValidator. Validate;
begi n

/1 Do not hi ng
end;

end.

Using this class it is possible to add error messages which will appear in the ASP.NET ValidationSummary control with the
following code

Page. Val i dators. Add(StaticValidator.Create(' This is an error nmessage'));

Creating a PageHelper class

As validation is likely to be performed on multiple pages it makes sense that the code to perform the validation should be in a
utility class.

1. Create a new class
2. Name it PageHelper and save the unit as PageHelperUnit

3. The implementation of the class is as follows

uni t PageHel per Unit;

interface
uses
Dr oopyEyes. EcoExt ensi ons. Val i dati on,
System Col | ecti ons. Generi c,
Syst em Web. Ul ,
Eco. Obj ect Represent ati on;

type
PageHel per = cl ass
private
publ i c
class function ValidatePage(Current Page: Page; AffectedCbject: |Objectlnstance):
Bool ean;
end;

i mpl erent ati on
uses StaticValidatorUnit;
{ PageHel per }

cl ass functi on PageHel per. Val i dat ePage( Current Page: Page; AffectedObject:
| Obj ect I nst ance): Bool ean;
var

Constraints: List<lConstraint>;

Current Constraint: |Constraint;

Val idator: StaticValidator;

14
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Constrai nt Provi der: Mddel edConst r ai nt Provi der;

begi n
Const rai nt Provi der : = Mbdel edConst rai nt Provi der. Cr eat e;
Result := True;

Constraints := List<lConstraint>. Create;
Constrai nt Provi der. Get Const r ai nt sFor Qbj ect ( Af f ect edCbj ect
for CurrentConstraint in Constraints do
if not CurrentConstraint.lsValid then
begi n
Val i dat or
Current Page. Val i dat ors. Add( Val i dat or) ;
Resul t Fal se;
end;
end;

end.

.= StaticValidator. Create(Current Constraint. Nange) ;

Constraints);

Note: You need to add DroopyEyes.EcoExtensions.Validation.dll to your project's references list.

Validating input

The EcoDataSource has two properties of relevance ValidateRowOninsert and ValidateRowOnUpdate. If these are True the
EcoDataSource's ValidatingRow event will be triggered whenever a new object is inserted or updated using the

EcoDataSource. This event allows the user to implement code which can determine

whether or not the changes are valid

and, if not, cancel the update. If the update is canceled an exception will be thrown. Implement the source for this event as

follows

procedur e TDef aul t. Aut hor Dat aSour ce_Val i dat i ngRow sender: TCb
Eco. Web. Ul . WebCont r ol s. EcoDat aSour ceObj ect Event Ar gs) ;
begi n
i f not PageHel per. Val i dat ePage( Page,
e. Cancel := True;

end;

e. Affectednj ect) then

j ect; e:

An exception being thrown when the user tries to enter invalid data is undesirable.
method IsValidNewValues which does the following

. Starts an in-memory transaction

1
2. Applies the new values to the object instance
3

4. Rolls back the in-memory transaction

5

. Returns the result of ValidatingRow

Therefore the EcoDataSource has a

. Triggers the ValidatingRow event to allow the page to determine whether or not the changes are valid

When the GridView control is about to update the values of a row it will execute its RowUpdating event. This event contains

information about the change such as a collection of the new values. Using this
EcoDataSource if the new values are valid as described above

information it is possible to ask the

procedure TDefaul t. Aut hor Gri dVi ew_RowUpdat i ng( sender:
Syst em Web. Ul . WebCont rol s. G'i dVi ewUpdat eEvent Ar gs) ;
begi n
i f not Aut hor Dat aSource. | sVal i dNewVal ues( e. Keys,
e. Cancel := True;
end;

TObj ect

e:

e. Newval ues) then

15
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If the EcoDataSource says the new values are not valid then the GridView will cancel its update. This prevents the GridView
from leaving the Editing mode and more importantly prevents it from attempting to update the EcoDataSource and therefore
avoiding the exception.

Testing the validation

Add a ValidationSummary control to the form from the tool palette. Then run the application again, edit an author and try to
update the row with an invalid email address. Instead of allowing the author to be updated the page will display an error
message and prevent the update from taking place.

This approach to validation is particularly valuable because object validity is determined by the business model, and
therefore the same rules may be applied across all user interface implementations.

Exercise for the reader

Create a new web form to enable you to add or remove article types (ArticleType class.) Make sure you add validation so
that users cannot enter invalid data and confirm deletion when the user clicks the Delete link.

16
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Passing objects between page
requests

Selecting an item from a list and then redirecting the user to a page that manipulates the selected item in some way is a very
common website feature. This next example will show how to select an author on the main page and then show the author's
articles. Afterwards another page will be added to deal with adding and editing articles.

Creating a link in the GridView control
1. Edit the columns on AuthorGridView.
2. Add a HyperLink column.
1. Set Text to Articles.
2. Set DataNavigateUrlFields to ID
3. Set DataNavigateUrlFormatString to

Aut hor Arti cl es. aspx?Aut hor ={ 0}

Now run the application again and click the Articles link next to an author, you will see that you are redirected to
http://localhost:8080/AuthorArticles.aspx?Author=1, which at the moment will display a Page Not Found error.

Creating the target page
1. Create a new ASP.NET page.
2. Add an EcoSpaceManager and set its properties.
3. Add an EcoDataSource.
1. Set its ID to ArticleDataSource.
2. Set its EcoSpaceManagerID to EcoSpaceManagerl.
4. Use the [...] editor on the Parameters property.
. Click the Add Parameter button.
. Name the parameter param_AuthorID - you may edit the name by single clicking the parameter name in the grid.
. Set the parameter's Parameter Source to QueryString
. Set the Query String Field to Author.

a A W N P

. Change "Type" to Int32.
6. Click OK.

5. Set the ArticleDataSource.PsExpression property to the following OCL expression

Aut hor . al | I nst ances- >sel ect (I D = param Aut horI D). Articl es

Note: param_AuthorID is case sensitive.

17
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6. Add a GridView to the form.

1. Setits ID to ArticleGridView

2. Set its DataSource ID to ArticleDataSource

3. Use the [...] editor on Columns so that you have only the following columns.
o Title
¢ MainState
* ReviewState
¢ AtrticleType

If you have articles in your database from running your VCL.NET application you will see them listed on the page. The
process works like this:

Default.aspx

1. When the list of authors is displayed on Default.aspx it will render a column named "Articles".
2. This column is a HyperLink column, its link is the url defined by DataNavigateUrlFormatString.

3. DataNavigateUrlFormatString is the string to be parsed in order to produce the final URL. To produce the final value it is
passed to the .NET String.Format method, allowing for runtime parameters to be injected into the string using
placeholders such as {0}, {1}, {2} and so on.

4. DataNavigateUrlFields contains a list of column names on the GridView's data source. The {0}, {1}, {2} etc are replaced
with the value of these columns. In this example {0} is replaced with the ID of the author, giving the value .....Author=1

AuthorArticles.aspx

1. The page is rendered, this causes the ArticleGridView to render.
2. The ArticleGridView requires data to bind to, so this data is retrieved from ArticleDataSource.

3. ArticleDataSource sees that it has a Parameter named "param_AuthorID", so it creates an OCL variable with the same
name.

4. The ArticleDataSource then sets the value of this variable as instructed; it sets it to the value of the AuthorID value in the
URL query string.

5. ArticleDataSource evaluates its PsExpression and then Expression in turn.

6. The PsExpression results in all authors with the specified ID (of which there can be only one) and returns that author's
articles.

Note: PsExpression was used instead of Expression so that the data filtering is performed in the database instead of loading
all Author instances into memory and filtering.

EcoDataSource.Parameters may be used to define OCL variables from a number of sources. This will be demonstrated
further when a master detail (@ see page 26) example is created.

18



Editing a single object

So far all editing has been performed as a list of objects in a GridView control. It is common for websites to allow the editing
of single objects on a page, providing a more complex page layout with controls such as embedded word processing for
editing article contents for example. This next example will show how to create a web form of this type.

Creating a link to the new page

Add a new column to the ArticleGridView in AuthorArticles.aspx. The column should be a HyperLink column with the
following settings

» Setits Text to Edit
» Set its DataNavigateUrlFields to ID
» Set its DataNavigateUrlFormatString to EditArticle.aspx?ArticlelD={0}

Creating the target page
1. Create a new ASP.NET Page named EditArticle.aspx.
2. Add an EcoSpaceManager to the form and set its EcoSpaceTypeName property.
3. Add an EcoDataSource to the form.
1. Set its ID to ArticleDataSource
2. Set its EcoSpaceManager to EcoSpaceManagerl
4. Add a new Parameter.
1. Set its Name to param_ArticlelD.
2. Set its Parameter Source to QueryString
3. Set its Query String Field to ArticlelD

5. Set the ArticleDataSource.PsExpression to

Article.alllnstances->select(ID = paramArticl el D)

6. Evaluations performed in the database using PsExpression must always return a collection of objects, even if there is only
one item in the collection. To obtain a reference to only a single article we must add an OCL expression to the Expression
property which will then be evaluated against the result of the PsExpression evaluation. Set
ArticleDataSource.Expression to

‘self->first

Note: "self" (which is case sensitive) refers to the element returned by evaluating PsExpression, which in this case is a
Collection(Article).

7. From the Web Data category in the tool palette add a FormView control to the form.
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1. Setits ID to ArticleFormView
2. Set its DataSourcelD to ArticleDataSource

Now run the application. Select the Articles link against an author, and then the Edit link against an article, you will now see
a read only display of the article selected with Edit, Delete, New links at the bottom.

Editing the article

As we intend to have the user edit the article rather than viewing it (a separate ShowArticle.aspx would make more sense in
this case anyway) we need to ensure that ArticleFormView goes immediately into Edit mode when the page is shown. In
addition we will remove the View template.

1. Right-click ArticleFormView and from the context menu select the Item Template item.

Toolbars 3

View In Browser
Browse With...
Add to Repository. ..

nd Template Editing

ItemTemplate
FooterTemplate

EditItemTemplate
InsertltemTemplate
HeaderTemplate
EmptyDataTemplate
PagerTemplate

2. The control will now allow you to edit the Item Template, which is the view you see by default. Select all of the controls
within the Item Template area and delete it.

AricleFormView- tem Template

ltem Template

3. Replace it with "Article editing control".
4. Now right-click the control again and select Edititem Template from the context menu.
5. Again select all of the controls within the template area and delete them.

6. Now add a table to the template's client area, edit the table so that it looks something like the following illustration.
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ArticleFormView- tem Template
Editkem Template
Title
Article type
Main state
Reviewing state
Description
Body

You may wish to copy / paste the following HTML into the ASPX file

<Edi t | t eniTenpl at e>
<t abl e border="1">
<t body>
<tr>
<th>Title</th>
<td></td>
</tr>
<tr>
<th>Article type</th>
<td></td>
</tr>
<tr>
<t h>Mai n state</th>
<td></td>
</tr>
<tr>
<t h>Revi ewi ng state</th>
<td></td>
</[tr>
<tr>
<t h>Descri pti on</t h>
<td></td>
</tr>
<tr>
<t h>Body</t h>
<td></td>
</tr>
</ t body>
<t f oot >
<tr>
<td col span="2"></td>
</[tr>
</tfoot>
</t abl e>
</ Edi tltenTenpl at e>

7. From the Web Controls category in the tool palette add a TextBox to the cell to the right of the cell entitled "Title". When
the text box is added you will see a Tasks window.

Editttem Template
[
Title
Edit DataBindings...
Article
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8. Click the Edit DataBindings link.

9. In the form that appears

1.
. Select the Field binding radio button.
. Set "Bound to" to Title.

a A~ W DN

Ensure that the Text property is selected in the list on the left.

. Ensure that Two-way databinding is checked.
. Click OK.

10. Sometimes these radio buttons will not be enabled, if you experience this you should perform the following steps instead.

1. Ensure that the Text property is selected in the list on the left.

2. The Custom binding radio button will be enabled by default.

3. In the Code expression text box enter Bind("Title")
4. Click OK.

11. Set the ID of the text box to TitleTextBox and its MaxLength to 64.

12. Now add text boxes for Description and Body, ensuring that you set the TextMode properties to MultiLine, and that you

set the MaxLength of Description to 255.

For the MainState and ReviewingState add Label controls instead, and data bind them using the same technique. Binding
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the article type will be covered later in this document.

Saving or cancelling changes

To add the ability to save or cancel changes two LinkButton controls will be added.

1. Add a LinkButton.

1. Setits ID to UpdateLinkButton

2. Setits Text to [Update]

3. Set its CommandName to Update
2. Add another LinkButton.

1. Set its ID to CancelLinkButton

2. Set its Text to [Cancel]

3. Set its CommandName to Cancel

4. Set its OnClientClick property to

return confirnm("Are you sure you want cancel your changes?");

We need to ensure that the form view automatically goes into edit mode when the page is displayed. Add the following code
to the Page.Load event

procedure TEditArticl e. Page_Load(sender: System Cbject; e: System EventArgs);
begi n

Arti cl eFor nVi ew. ChangeMode( For nVi ewibde. Edi t) ;
end;

To return to the author's list of articles once the changes have been saved or canceled add the following code to
ArticleFormView.ModeChanged

| Too

Run the application and navigate to an article. You will see that Ul is populated with the values of the selected article. You
may modify these values and then click either Update or Cancel.

Databinding a dropdown list

Next a drop down list will be added to the EditArticle form. This drop down list will present the user with a list of all available
ArticleType instances from which the user may choose the correct type for the current article. By default the current
Article.ArticleType should be selected in the drop down list and when the user clicks the Update link the article should be
updated with the currently selected article type.

1. Add an EcoDataSource to the form
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1. Setits ID to ArticleTypeDataSource
2. Set its EcoSpaceManagerID to EcoSpaceManagerl

3. Set NullRowMode to First. This will add an empty row at the top of the list of article types so that null values may be
represented.

4. Set its Expression to

Articl eType. al | | nst ances- >or der By( nane)

2. Add a DropDownlList to the cell to the right of the label "Article type"

1. On the Tasks window select Choose Data Source

2. Set the data source to ArticleTypeDataSource
3. Set the display field to Name
4. Set the value field to Externalld

This will populate the drop down with a list of all article types in the data storage. It will display the Name of each, but the
SelectedValue property will return the Externalld of the object.

Note: The Externalld is a string representation of a reference to an instance of a modeled class.

Updating the article's property

The drop down should display the current article's ArticleType by default, and this property must also be updated to the
selected value when the user clicks the Update link. The web form already knows that the binding context for the drop down
is the current article because it is parented within a FormView which has its DataSourcelD set to ArticleDataSource, so all
that is required is to specify which column the current value should be data bound to.

1. On the Tasks window select Edit DataBindings
2. In the bindings form ensure that SelectedValue is two-way bound to ArticleType

Note: If only the Custom Binding radio button is enabled you should enter Bind("ArticleType") as the expression.

There is one final step to perform. When the user interfaces attempts to set the default selected item in the drop down list it
will attempt to locate Article.ArticleType in a list of Externalld's, however, columns created automatically by the
EcoDataSource to represent single-role associations (links to a single ECO object) are added with the following expression

sel f.Articl eType.asString

The purpose of this is to enable the object to be displayed in a grid etc as a meaningful piece of text such as "Mr Peter
Morris". Unfortunately this is incompatible with what we are currently trying to achieve. Not only do we not want to see the
default string representation of the article type, we do not want the object reference either. What we need is a way to read
and write the value as an Externalld string.
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. Use the [...] editor on the ArticleDataSource columns property.
. In the form that appears click the Add button to add a new column.
. Name the new column ArticleType

. Set its expression to self.ArticleType

a A W N -

. Set AsExternalld to True

Note: When columns are created automatically at runtime the ArticleDataSource will see that a column named "ArticleType"
already exists and will skip creating the column automatically.

Now when the article type drop down list's default value is determined it will read the ArticleDataSource.ArticleType column
and find a string. This string represents the Externalld of the referenced ArticleType. When a new value is selected in the
drop down list and the Update button is clicked the value of ArticleDataSource.ArticleType will be set to
ArticleTypeDropDownList.SelectedValue which will be the Externalld for the currently selected article type.
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Master / detail

This example will demonstrate how to create master / detail relationships. Selecting an Author in a master grid will reveal all

related Articles in a second grid, the user will also be able to add / delete Articles.

Adding the master grid
1. Choose the menu item File->New->Other.
2. Select the Delphi for .NET Projects node in the tree view.
3. Select the New ASP.NET Files node.
4. Select ASP.NET Page and click OK.

5. Name the new item MasterDetail.aspx.
6. On the Default.aspx form add a hyperlink to MasterDetail.aspx.
7. Add an EcoSpaceManager to the form.
1. Setits EcoSpaceTypeName property.
8. Add an EcoDataSource to the form.
1. Set its ID to AuthorDataSource.
2. Set its EcoSpaceManagerID to EcoSpaceManagerl.
3. Set its Expression to "Author.allinstances".
9. Copy the AuthorGridView from Default.aspx and paste it into the form.
1. Set AutoGeneratedEditButton to False.
2. Set AutoGenerateSelectButton to True.

3. Use the [...] Columns editor and remove the Delete column.
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Adding the detail grid

Now we have a read only grid showing all existing authors, next a child grid will be displayed showing all articles for an
author whenever the Select column next to an author is clicked.

1. Add another EcoDataSource to the form.
1. Setits ID to ArticleDataSource.
2. Set its EcoSpaceManagerID to EcoSpaceManagerl.

Now to make the ArticleDataSource aware that it is a child of the selected author.

2. Use the [...] editor on the Parameters property.
1. Click the Add Parameter button.

2. Give the new parameter the name param_AuthorExternallD - you may single-click the name in the grid to edit it if you
wish to change it.

3. From the drop down list set its Parameter Source to Control.
4. Set its ControlID to AuthorGridView.
5. Click OK.

3. Edit the Expression and enter the following OCL

Aut hor . obj ect f r onExt er nal | d( par am _Aut hor External I D). arti cl es

Note: param_AuthorExternallD is case sensitive.

4. Add a GridView to the form.

1. Setits ID to ArticleGridView.

2. Set its DataSourcelD to ArticleDataSource.

3. Edit the columns and remove all columns except for the following
o Title
¢ MainState
* ReviewState
e ArticleType

4. TODO
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